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PRORAČUNSKE TABLICE (Microsoft Excel) 

Program za izradu i uređivanje tablica, računanje u tablicama, izradu grafikona itd. 

Pokretanje programa:   

Start – Programs – Microsoft Excel, dvoklik na ikonu Excela na Desktopu (ako postoji), lijevi 
klik na ikonu u taskbaru. 

Radna knjiga: (Workbook, Excel dokument) 
 Vrsta dokumenta u Excelu, osnovni element (datoteka) Excela (isto što je dokument u 

Wordu). Automatski se otvara kad pokrenemo Excel ili pomoću File – New – OK ako je Excel 
već pokrenut. 

Radni list: (Worksheet ili Sheet) 
 Osnovni dio radne knjige, sadržava tablicu ili grafikon (može ih biti više u radnoj knjizi). 
 Tokom rada možemo dodavati ili brisati radne listove  unutar radnje knjige. 
 Ispunjen je retcima i stupcima, a svaki redak i stupac imaju svoju oznaku (retci – 1, 2, 3, 4, ...., 

65536,  stupci – A, B, C, D, ..., Z, AA, AB, ..., IV) 

Polje (ćelija, engl. cell): 
 Osnovni dio radnog lista. Predstavlja presjek retka i stupca. (jedna ''kućica'' u tablici) 
 Može sadržavati podatke (tekst, brojevi,...) ili formule (pomoću kojih računamo) 
 Npr. polje C4 se nalazi na presjeku stupca C i 4. retka. 

Aktivna ćelija:  
 Ćelija uokvirena debljim pravokutnikom (označena ćelija). Samo u aktivnu ćeliju možemo 

upisivati podatke. Ćeliju aktiviramo (označimo) tako da kliknemo na nju. 
 

Osnovni elementi Excelovog prozora: 

• Naslovna traka 
Sadrži ime programa, ime dokumenta (radne knjige – Book1) i gumbe za rad s prozorima 

• Traka izbornika (Menu bar) 
Sadrži izbornike u kojima se nalaze srodne naredbe (standardno ih ima 9: File, Edit, View, Insert, 
Format, Tools, Data, Window, Help) 

• Alatna traka (Toolbar) 
Sadrže ikone često korištenih naredbi (kraći put do naredbi iz izbornika), aktiviramo ih klikom na 
ikonu. 

• Okvir naziva 
Prikazuje adresu aktivne ćelije (npr. C4) ili broj redaka i stupaca prilikom označavanja ćelija (npr. 
6R×5C). 

• Traka formule 
Prikazuje sadržaj ćelije ili formulu 

• Klizne trake (kliznici) 
Za pomicanje po radnom listu, ako se on ne vidi u cjelosti. 

• Kartice radnih listova 
Sadrži imena radnih listova u radnoj knjizi. Klikom na ime radnog lista možemo otvoriti taj radni 
list. 

• Zaglavlje stupaca 
Sadrži oznake stupaca (A, B, C, D, ..., AA, AB, ..., AZ, ..., IV) 

• Zaglavlje redaka 
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Sadrži oznake redaka (1, 2, 3, ..., 65536) 
• Traka stanja (statusna traka) 

Sadrži informacije o stanju programa (koje su opcije i tipke uključene i sl.) 

Namjena skupina naredbi u traci izbornika: 
 

Engleski naziv Hrvatski naziv Namjena 
File Datoteka Otvaranje, zatvaranje, spremanje, ispis, ... 
Edit Uređivanje Kopiranje, premještanje, brisanje, mijenjanje podataka 
View Pogled Mijenjanje izgleda prozora, uključenje i isključenje traka itd. 
Insert Umetanje Umetanje slika, grafikona, objekata, redaka, stupaca 
Format Oblikovanje Oblikovanje podataka, redaka, stupaca, tablica, ... 
Tools Alati Za složenije računanje, zaštitu i različite prilagodbe 
Data Podaci Za rad sa podacima u tablici, npr. sortiranje i sl. 
Window Prozor Za rad sa prozorima (naročito kada radimo s više prozora) 
Help Pomoć Za dobivanje pomoći, savjeta i objašnjenja vezana uz program 

 

Osnovne operacije unutar radnog lista: 
 
Kretanje radnim listom: vrši se kursorskim tipkama ← ↑ → ↓ (strelicama), pri ćemu će ćelija na koju 
se pomaknemo postati aktivna. (Veći pomaci po radnom listu vrše se kliznicima ili tipkama PageUp i 
PageDown, Home – pomak na početak reda, Ctrl+Home – pomak na prvu ćeliju u radnom listu: A1 
itd.) 

Označavanje dijelova tablice: 

Pojedine ćelije:  Klikom unutar te ćelije 

Grupe susjednih ćelija (ćelije koje su u nizu): 
Kliknemo mišem na jednu od kutnih ćelija grupe i držeći pritisnutu lijevu tipku miša povlačimo 
pokazivač dijagonalno do suprotnog kuta grupe. 

Ćelija (ili grupa ćelija) koje nisu u nizu: 
Držeći tipku Ctrl dok mišem označavamo ćelije.  

 
 

 

 

Označene grupa ćelija u rasponu od B2 

do C8 i E5 do E12 
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Cijelih redaka ili stupaca 
Cijeli redak ili stupac označavamo tako da kliknemo na zaglavlje retka ili stupca koji želimo označiti.  

Označen peti redak     Označen stupac C 

 

Više susjednih redaka ili stupaca: 
Kliknemo na zaglavlje (oznaku) retka (ili stupca) i povučemo mišem preko susjednih redaka ili 
stupaca.  
Više razdvojenih redaka ili stupaca: 
Držeći tipku Ctrl dok mišem označavamo retke ili stupce.  

Cijelog radnog lista 
Kliknemo mišem na sivi pravokutnik između zaglavlja (oznaka) redaka i stupaca (lijevo gore) ili 
kombinacijom tipki Ctrl + A. 

Napomena: Označavanje poništavamo klikom na bilo koju ćeliju tablice radnog lista. 

Označavanje pojedinih ili  proizvoljno mnogo ćelija kao i proizvoljne grupe ćelija vršimo upisom 
oznaka ćelija u okvir naziva (koristeći znakove : i ;) u polje za s oznakama ćelija. 

Brisanje sadržaja ćelije:  

• označimo (aktiviramo) jednu ili više ćelija i pritisnemo tipku <Delete>. Pri tom će se obrisati 
samo sadržaj ćelije, a postojeće karakteristike ćelije će ostati iste.  

• označimo jednu ili više ćelija, a zatim odaberemo Edit - Clear te u podizborniku Contents (za 
brisanje samo sadržaja ćelije), Formats (za brisanje karakteristika tj. formata ćelija), 
Comments (za brisanje komentara unutar ćelija), All (za brisanje svega navedenog) 

Promjena sadržaja ćelije: dvoklikom ''uđemo'' u prostor ćelije, a zatim napravimo potrebnu promjenu 
(postupamo kao u Wordu) koristeći tipke sa strelicama, <Backspace> i <Delete>. Ukoliko označimo 
ćeliju, a zatim počnemo s upisom, stari sadržaj ćelije će briše. 
 

Rukovanje Excel dokumentom (radnom knjigom): 

• Otvaranje nove radne knjige: File – New – Blank Workbook (ili klik na  ) 
• Otvaranje postojeće radne knjige: File – Open (ili klik na  ) 
• Zatvaranje radne knjige: File – Close (ili klik na unutarnji  ) 
• Pohranjivanje nove radne knjige: File – Save As 
• Pohranjivanja promjena u postojećoj radnoj knjizi: File – Save (ili klik na  ) 
• Izlaz iz programa: File – Exit (ili klik na vanjski  ) 
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Operacije s radnim listovima: 

Umetanje novog radnog lista:   

Označimo radni list ispred kojeg želimo umetnuti novi i daberemo naredbu Insert > Worksheet. 
Promjena imena radnog lista: 
Desni klik na oznaku radnog lista – Rename – upis novog imena - Enter 

Premještanje radnog lista: 
Kliknemo mišem na karticu radnog lista i držeći pritisnutu lijevu tipku miša, odvučemo karticu na 
novo mjesto.  
Brisanje radnog lista: 
Desni klki na radni list kojeg želimo izbrisati i izaberemo naredbu Delete 

Operacije s recima i stupcima: 

Čišćenje: 
1. Označimo ćeliju ili grupu ćelija koju želimo očistiti 
2. Odaberimo Edit > Clear > jedna od naredbi All, Formats, Contents, Comments ovisno da li 

želimo : Sve, Oblikovanja, Sadržaj ili Komentare. 

Brisanje: 
Označimo ćeliju, grupu ćelija, redak ili stupac te odaberemo Edit > Delete za brisanje 

Umetanje redaka: 
Označimo redak (ispred kojeg želimo umetnuti novi redak) i daberemo Insert > Rows 

Umetanje stupaca: 
Označimo stupac (ispred kojeg želimo umetnuti novi redak) i odaberemo Insert > Columns 

Umetanje više redaka ili stupaca odjednom: 
Isto kao i prije samo što prethodno označimo više redaka (stupaca) ili ćelija u retku (stupcu). Excel će 
dodati odgovarajući broj novih redaka (stupaca) ispred onih označenih.  

Promjena širine stupca i visine retka 
1. način: Postavimo pokazivač miša na razdjelnicu dva stupca (ili retka)u zaglavlju (pokazivač 
poprimi izgled dvostrane strelice). Pritisnemo lijevu tipku miša i povlačimo pokazivač lijevo ili 
desno do željene veličine.  

2. način: Označimo stupac (ili redak) i odaberemo naredbu Format 
> Column > Width (za stupac) ili Format > Row > Height (za 
redak). Otvara se dijaloški okvir u koji unosimo vrijednost željene 
širine stupca (ili retka). 
 

Napomena: Ako želimo promijeniti širinu više stupaca (ili redaka) odjednom, najprije ih označimo i 
tek tada izvršimo promjenu na prethodno opisani način..  

Promjena širine stupca prema njegovom najširem zapisu: 
1. način: Dvostruki klik miša na razdjelnicu dva stupca.  
2. način: Označiti te stupce i odabrati Format > Column > AutoFit Selection 

Poništavanje posljednje operacije (UNDO): 
Edit > Undo ( Edit > Redo ako smo se predomislili)  
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Vrste (tipovi) podataka u Excelu: 

1. TEKST – lijevo poravnat u ćeliji 

2. BROJ (VRIJEDNOST) – desno poravnat u ćeliji 
a. konstanta (5; 35; 756) 
b. datum (15.05.97.) 
c. vrijeme (17:43) 

3. FORMULE, npr. = A1 + A2 + A3 

TEKST:      BROJEVI: 
npr. Marko    npr. 123  29.09.2005 
 Škola     5,85  15:35 
 Marko123    9,9E+08 30-ožu-01 
 3456X     - 125,5 
 Kaptol 16    5,23E-03 

  ‘96 

Kada se unutar ćelije pojavi znak  ######  to znači da širina stupca nije dovoljna za prikaz broja, pa 
trebamo proširiti stupac da bismo vidjeli broj.      

Excel je svakom datumu pridružio redni broj: 

• najraniji datum koji Excel razumije je 1.1.1900. – njemu je pridružio broj 1 
• datumu 2.1.1900. – pridružio je broj 2 itd. 

Na taj način možemo oduzimati datume i izračunati kojliko je vremena prošlo od jednog do drugog 
datuma. 

Poravnavanje podataka u ćeliji: 

• Horizontalno poravnavanje: 
1.) Označimo ćelije čije sadržaje želimo poravnati 
2.) Iz alatne trake kliknemo na željeno poravnavanje 

• Vertikalno poravnavanje 
1.) Označimo ćelije čije sadržaje želimo poravnati 
2.) Otvorimo prozor dijaloga Format – Cells  
3.) Odaberemo karticu Alignment 
4.) Unutar polja Vertical izaberemo način poravnavanja 

Prikazivanje brojeva u tablici: Način na koji će se brojevi prikazivati (vidjeti) unutar ćelije možemo 
odrediti koristeći dijaloški prozor Format – Cells – Number (npr. podešavanje broja decimala, valute, 
postotak, razlomci, ...) 

Kopiranje i premještanje podataka (Cut, Copy, Paste): 
One koriste međuspremnik (clipboard) kao privremeno skladište za odabrane podatke. Naredbe Copy 
i Cut spremaju podatke u međuspremnik, a naredba Paste ih ubacuje na željeno mjesto u radnom 
listu. 
Kopiranje sadržaja ćelija: 

1. način: 
1. Označite sadržaj koji želite kopirati 
2. Desnim klikom miša na označenom području, otvorite brzi izbornik 
3. Odaberite naredbu Copy 
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4. Klikni na ćeliju u koju želite kopirati sadržaj 
5. Desnim klikom miša otvorite izbornik prečica i odaberite naredbu Zalijepi. 

Sadržaj će se kopirati počevši od ćelije koju smo označili pod 4. (pa udesno prema dolje) 

2. način: (povlačenjem pomoću miša) 
Odaberete ćelije koje želite kopirati. Pomaknete pokazivač miša na neku od granica označenog 
područja. Pokazivač miša promjeni izgled u oblik četverostrane strelice. Pritisnite tipku Ctrl. Uz 
pokazivač miša pojavit će se mali plus. Držeći tipku Ctrl povlačenjem miša premjestite označene 
ćelije na željeni mjesto. 

Premještanje sadržaja ćelija:  

1. način: 
1. Označiti ćelije koje želimo premjestiti 
2. Odabrati naredbu Cut (sadržaj se prebacuje u međuspremnik) 
3. Kliknuti na ćeliju u koju želite premjestiti sadržaj 
4. Odabrati Paste (zalijepiti sadržaj iz međuspremnika) 

2. način (povlačenjem pomoću miša): 
Najprije označite ćeliju ili grupu ćelija koje želite premjestiti. Pomaknete pokazivač miša na neku od 
granica označenog područja i povučemo sadržaj do željene pozicije. 

Napomena: Kod kopiranja grupe ćelija u drugu grupu ćelija, obje grupe moraju biti jednake veličine. 

Automatsko popunjavanje ćelija: 
Excel omogućava automatsko popunjavanje susjednih ćelija: 

1.) kopiranjem sadržaja 
2.) kreiranjem niza podataka 

1.) način koristimo kada želimo unijeti isti sadržaj u više ćelija tako da: 
• označimo ćeliju čiji sadržaj želimo kopirati 
• uhvatimo hvataljku u desnom donjem kutu te ćelije 
• razvučemo okvir na one ćelije u koje želimo kopirati označeni sadržaj 
• otpustimo lijevu tipku miša 

2.) način koristimo kada želimo upisani niz od nekoliko brojeva produljiti na iduće ćelije 
• označimo ćelije koje predstavljaju upisani niz brojeva 
• uhvatimo hvataljku u desnom donjem kutu te ćelije i razvučemo okvir na one ćelije u 

kojima želimo nastaviti niz 
• otpustimo lijevu tipku miša 

Excel pamti određene nizove podataka (dani u tjednu, brojevi, mjesece itd.), a prepoznaje i svaku 
riječ koja se nalazi u nekom od zapamćenih nizova.  

Također, korisnik može kreirati i svoje vlastite nizove. 

Nizove koje Excel prepoznaje možemo vidjeti pod: Tools – Options – Custom Lists, a na istom 
mjestu možemo formirati i nove. 
 
 
 
 
 
 

Vježbe: 1.) U ćelije od B5 do B10 upišite niz brojeva koji započinje brojem 5, a završava s 10. 
 2.) U ćelije od A2 do A8 unesite dane tjedna. 
 3.) U ćelije od C2 do C10 unesite slova od 'a' do 'i'. 
 4.) U ćelije od D2 do D20 unesite sve datume od 21.10.2001. do 8.11.2001 
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Oblikovanje podataka u ćeliji: (Format - Cells) 
Sve podatke koje smo unijeli možemo i naknadno oblikovati. Oblikovati možemo vrijednosti u 
ćelijama, sadržaj ćelija, poravnavanje sadržaja unutar ćelija, znakove, rubove itd. 

  
Kartice: 
• Number - oblikovanje brojevnih vrijednosti 

(brojevi, datumi, vrijeme, valute, postoci, 
razlomci, tekst,... 

• Alignment - poravnavanja, orijentacija 
teksta, spajanje ćelija i sl. 

• Font - odabir vrste, veličine, boje slova i sl. 
• Border - oblikovanje rubova i okvira ćelija 
• Pattern – umetanje grafičke pozadine 
• Protection - za zaštitu radnog lista, polja, 

formula i sl. 
 
 
 
 
 

 
Oblikovanje brojevnih vrijednosti (Number): 
Omogućava oblikovanje brojeva. 
Oblikovanje se vrši tako da najprije označimo ćelije koje želimo oblikovati, a zatim unutar Format - 

Cells i kartice Number odaberemo jednu od 12 kategorija brojeva. Nakon klika na OK, u označenim 
ćelijama promijenit će se oblikovanje. 
Napomena: Prilikom unosa u tablicu, brojevi se inicijalno prikazuju u općem obliku (General) tj. 
Excel unesene podatke prihvaća i prikazuje u onom obliku u kakvom je predviđeno (npr. 2,85 kao 
decimalni broj, 2.8 kao datum i sl.).  

Neki od oblika:  
Number - prikazuje broj na željeni broj decimala (u polju Decimal places) 
Currency - prikazuje broj s oznakom jedne od odabranih valuta (kn, $, €, itd.) 
Date (Time) - prikaz broja u obliku datuma odnosno vremena 
General - prikazuje broj onako kako smo ga unijeli ili automatski pretvara u jedan od predviđenih 

oblika 

Fraction - prikazuje broj u obliku razlomka 

Pomoću alata   i    možemo povećati odnosno smanjiti broj decimalnih mjesta u prikazu broja. 

Poravnavanje podataka u ćelijama (Alignment): 

Tijekom unosa podaci se u ćelijama inicijalno poravnavaju prema tipu podataka (npr. tekst ulijevo, 
brojevi udesno i sl.). Nakon unosa podatke možemo poravnati po vlastitom odabiru pomoću kartice 
Alignment ili alatima za poravnavanje na alatnoj traci. 
Horizontalno poravnavanje vrši se unutar  polja Horizontal (npr. General, Left, Right, Center,...), a 
vertikalno unutar polja Vertical (npr. Top, Bottom, Cnter, Justify) odabirom vrste poravnavanja. 

Kut pisanja unutar ćelija možemo podesit unutar polja Orientation. 
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Spajanje ćelija: 

• označimo ćelije koje želimo spojiti 
• odaberemo Format – Cells – Alignment 
• uključimo opciju Merge Cells 

Oblikovanje teksta (Font) 
Promjenu tipa, veličine, stila i boje slova možemo 
vršiti unutar kartice Font, a način odabira identičan 
je onom u Wordu i drugim standardnim programima. 

 

 
 

 

 
 

Izrada okvira i rubova (Border) 
 

Pomoću kartice Border možemo tablici (ili 
pojedinim ćelijama, retcima, stupcima) dodavati 
okvire i rubove (horizontalne i vertikalne).  

U desnom dijelu prozora (Style) odabire se vrsta 
rubne linije, a u polju Color njezina boja dok u 
okviru Border uključujemo i isključujemo pojedine 
rubne linije klikom na alat koji predstavlja pojedinu 
liniju.  

Sadržaj okvira predstavlja prethodno označeni dio 
tablice. 
 
 
 

 
 

Umetanje grafičke pozadine (Patterns) 

Unutar kartice Patterns možemo ćelijama unutar tablice 
dodati grafičku pozadinu  klikom na željenu boju u 
paleti (ili odabirom uzorka unutar polja Pattern). 
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Računanje u tablici: 

Excel omogućava računanje s vrijednostima unutar ćelija. Osim što možemo koristiti osnovne 
računske operacije, na raspolaganju je i nekoliko stotina funkcija podijeljenih u više kategorija: npr. 
matematičke, statističke, financijske, logičke, funkcije datuma i vremena, funkcije za rad s tekstom 
itd. 

U svakoj formuli možemo upotrijebiti neke os sljedećih elemenata: 

• brojevne vrijednosti 
• adrese ćelija 
• operatore 
• funkcije 
• tekst 

 
 
 

Po znaku ' = ' Excel razlikuje formulu od običnog teksta. 
 
Primjeri jednostavnih formula: 

= B2+B3 
= A5-10 
= (A1/A2+5)*100 

 
Adrese u Excelu: 

Svaka ćelija u tablici je jednoznačno određena svojom adresom. Nju čini oznaka stupca i broj 
retka na čijem sjecištu se nalazi. 

Vrste adresa: 

1.) Relativna adresa – najčešći oblik adrese, zapisuje se kao npr. C4, A10, CX23 i sl. 
Čine ju samo oznaka stupca i broj retka. 

Relativnu adresu koristimo kad želimo da se adresa ćelije mijenja pri korištenju, tj. adresa se 

povećava ili umanjuje za onoliko brojeva stupaca i redaka za koliko smo ćelija pomaknuli izraz u 

odnosu na početnu ćeliju 

Npr., ako formulu s adresom ćelije C4 kopiramo u sljedeći redak adresa će biti C5, pa zatim C6 itd. 
Time postižemo da se u svakom retku računa s vrijednošću iz tog retka. Isto vrijedi i za stupce. 

2.) Apsolutna adresa - osim oznake retka i broja stupca sadrži i znak $, koji se stavlja ispred oznake 
retka i broja stupca, npr. $C$4, $B$9, itd. 

Apsolutnu adresu koristimo kad ne želimo da se adresa ćelije mijenja pri korištenju, tj. za formulu u 
svakom retku ili stupcu koristi se vrijednost iz iste, točno određene ćelije. 

Takva se adresa pri kopiranju ili premještanju ne mijenja. 

Jednostavne formule: 

Upisivanje formule započinjemo znakom =, a nakon toga slijede brojevi, računske operacije, adrese 
ćelija itd. 

Formula se prilikom upisivanja pojavljuje u ćeliji i u traci formule. 

VAŽNO:  Svaka formula uvijek započinje znakom  =  .  
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Nakon upisa i izvršenja formule u ćeliji će se vidjeti izračunata vrijednost, a u traci formule sama 
formula. 

Excel dozvoljava da umjesto upisivanja adrese ćelije u formulu možemo jednostavno kliknuti mišem 
na ćeliju čiji sadržaj želimo uključiti u formulu. Na taj način možemo u formulu uključiti i više ćelija, 
cijeli redak, stupac i sl. 

Znakovi za osnovne računske operacije: 

1.  množenje  * 
2.  dijeljenje  / 
3.  zbrajanje  + 
4.  oduzimanje   - 

Kopiranje formule: 
Formule smještene u ćelije možemo kopirati, a rezultat kopiranja ovisi o tome kakve se formule 
nalaze u ćelijama koje se kopira. 
Ako kopiramo formulu koja sadrži relativne adrese, Excel će automatski promijeniti adrese u ćelijama 
u koje se kopira. 
Ako kopiramo formulu koja sadrži apsolutnu adresu, ona će ostati nepromijenjena u ćelijama u koje 
se kopira. 
 
 
 

 
 

Funkcije: 

Funkcije se koriste kao sastavni dio formula, a omogućavaju različita računanja kao npr. zbroj, 
prosjek, minimum, maksimum, prebrojavanje itd. 

Svaka se funkcija sastoji od imena funkcije i skupa argumenata koji navodimo u okruglim 
zagradama. 

Argumenti funkcije su vrijednosti za koje se pojedina funkcija računa.  

Npr.  

= SUM (A3:A10)  Funkcija za zbrajanje i njezini argumenti 

 

Ime funkcije  Argumenti funkcije 

Ukoliko želimo kao argument upotrijebiti niz ćelija, onda pišemo raspon. 

Raspon: prva ćelija u nizu – znak dvotočke – zadnja ćelija u nizu    (npr. A3:A10) 

 
Funkcija za zbrajanje:  SUM 
 pišemo:  = SUM (A3:A10)     →  Zbraja sve ćelije u navedenom rasponu (A3 do A10) 

(To je lakše pisati nego = A3 + A4 + A5 + A6 + A7 + A8 + A9 + A10) 
 
 

Zaključak: Ćelije koje sadrže relativne adrese mijenjaju se prilikom kopiranja, dok se ćelije koje  
sadrže apsolutne adrese ne mijenjaju. 
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;   znak odvajanja u formulama 
klj 

Funkcija za nalaženje minimuma: MIN 
pišemo:  = MIN (B3:D8)      →   Nalazi najmanju brojčanu vrijednost u navedenoj  

grupi ćelija (rasponu) 

Funkcija za nalaženje maksimuma: MAX 
pišemo:  = MAX (AB2:AF7) →   Nalazi najveću brojčanu vrijednost u navedenoj  

grupi ćelija (rasponu) 

Funkcija za računanje prosječne vrijednosti: AVERAGE 
pišemo:  = AVERAGE (B2:B7) →  Računa prosjek brojeva u navedenom grupi ćelija 
      (rasponu) 

Uvjetna funkcija: IF 

= IF (uvjet; operacija1; operacija2) →  Ako je uvjet ispunjen izvodi se operacija1, a ako  
nije izvodi se operacija2 

npr. 1.) = IF (A2>A5; C3 - C5; SUM (D4:D9))   

→  ako je sadržaj ćelije A2 veći od sadržaja ćelije A5 onda izračunaj C3-C5, inače 
izračunaj sumu ćelija od D4 do D9. 

 2.) = IF (SUM (B3:C5)>=10; ''PORUKA1''; ''PORUKA2'') 

→  ako je suma ćelija od B3 do C5 veća ili jednaka 10 onda ispiši ''PORUKA1'', inače 
ispiši ''PORUKA2'' 

 3.) = IF (AVERAGE (A2:A10)>=4,5; ''Uspjeh je odličan'', ''Uspjeh nije odličan'') 

  →  ako je prosjek ćelija A2:A10 veći ili jednak 4,5 ispiši ''Uspjeh je odličan'', inače  
ispiši ''Uspjeh nije odličan''  

 
 

 

Funkcija za prebrojavanje brojeva: COUNT 

= COUNT (raspon) → prebrojava koliko ima ćelija u zadanom rasponu koje sadrže brojeve 

npr. 1.) = COUNT (A3:A8) 

→  prebrojava koliko ima ćelija u rasponu A3:A8 koje sadržavaju brojeve 

Uvjetna funkcija za prebrojavanje: COUNTIF 

= COUNTIF (raspon; uvjet)     →   prebrojava koliko ima ćelija u zadanom rasponu koje  
ispunjavaju zadani uvjet 

 
npr. 1.) = COUNTIF (A3:A8; ''>10'') 

  →  prebrojava koliko ima ćelija u rasponu A3:A8 čiji je sadržaj veći od 10 

 2.) = COUNTIF (B1:B10; ''odličan'') 

  → prebrojava koliko ima ćelija u rasponu B1:B10 u kojima piše ''odličan'' 

 3.) = COUNTIF (C3:D10; 3) 

  → prebrojava koliko ima ćelija u rasponu C3:D10 koje sadrže vrijednost 3 
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POSTAVKE STRANICE 

Ako želimo svoje radove otisnuti na papir moramo pravilno podesiti izgled stranice kao npr. margine, 
zaglavlje, podnožje, orijentacija stranice i sl. 

Za promjenu postavki stranice odaberemo File – Page Setup. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Kartica Page: 
Unutar nje možemo odrediti usmjerenje stranice (Portrait, Landscape), veličinu (format) papira (A4, 
A5, Letter,...), kvalitetu ispisa (600 dpi, 300 dpi,...), faktor smanjenja ili povećanja i sl. 

Margine stranice (kartica Margins): 

Unutar kartice Margins možemo podešavati veličinu margina (udaljenost sadržaja stranice od rubova 
papira) upisujući te udaljenosti (u cm) u za to predviđena polja (Top, Left, Bottom, Right). 

Zaglavlje i podnožje (kartica Header/Footer): 

Zaglavlje (Header) - prostor između gornje margine i gornjeg ruba stranice 
Podnožje (Footer) - prostor između donje margine i donjeg ruba stranice 

Područja zaglavlja i podnožja najčešće se koriste za upis nekih standardnih sadržaja kao npr. datum, 
vrijeme, broj stranice, ukupni broj stranica, umetanje slike i sl. 

Odabirom kartice Header/Footer otvara se okvir za uređivanje zaglavlja i podnožja, a isto možemo učiniti 
i odabirom View – Header and Footer.  
Vlastito zaglavlje ili podnožje možemo sami urediti odabirom gumba Custom Header (za zaglavlje) 
odnosno Custom Footer (za podnožje). 
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Pomoću ikona iz okvira možemo unijeti razne vrste sadržaja u 3 različita dijela zaglavlja ili podnožja 
(lijevi dio, sredina i desni dio). 

 

 
 
Namjene ikona (redom):          promjena fonta ,     unos trenutnog broja stranice ,  

unos ukupnog broja stranica ,   unos datuma ,  unos vremena , 

 unos položaja i imena radne knjige , unos imena radne knjige ,  

unos imena radnog lista , umetanje slike , uređivanje umetnute slike 

 
Kartica Sheet: 
 

 

 

 

 

 

 

 

 

 

 

 

Pomoću sadržaja ove kartice možemo odrediti neke opcije ispisa.  
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Zamrzavanje redaka i stupaca: 

Zamrzavanje redaka i stupaca omogućuje da ti retci ili stupci budu uvijek vidljivi bez obzira kako i 
koliko se pomičemo po tablici gore-dolje ili lijevo desno. 

Zamrzavanje stupca:  
• označimo prvi stupac desno od stupca kojeg želimo zamrznuti 
• odaberemo Window – Freeze Panes 

Zamrzavanje retka:  
• označimo prvi redak ispod retka kojeg želimo zamrznuti 
• odaberemo Window – Freeze Panes 

Odmrzavanje redaka i stupaca: odaberemo Window – Unfreeze Panes 

 

Traženje i zamjena podataka: 

Traženje podataka:  
• odaberemo Edit – Find 
• unutar otvorenog okvira, u polje Find What upišemo sadržaj kojeg želimo pronaći (npr. riječ 

„škola“) 
• kliknemo na gumb Find Next 

Zamjena podataka:  
• odaberemo Edit – Replace 
• unutar otvorenog okvira, u polje Find What upišemo sadržaj kojeg želimo zamijeniti (npr. 

riječ „škola“) 
• u polje Replace With upišemo sadržaj s kojim ga želimo zamijeniti (npr. „razred“) 
• ako kliknemo na gumb Replace zamijenit će se samo prvi pronađeni podataka dok će se 

klikom na gumb Replace All zamijeniti svi pronađeni podaci 
• klikom na gumb Find Next traži se sljedeće pojavljivanje traženog sadržaja, ali bez zamjene 

 
Sortiranje (redanje) podataka 

Podatke u tablici moguće je poredati (sortirati) po uzlaznom ili silaznom redosljedu, tj. od najmanjeg 
prema najvećem i obratno. 

• označimo dio tablice koji želimo 
sortirati 

• odaberemo Data – Sort 
• unutar okvira Sort odaberemo po 
čemu želimo sortirati te da li želimo 
sortirati uzlazno (Ascending) ili 
silazno (Descending)  

• nakon klika na gumb OK sadržaj će 
se sortirati 
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NEKE MATEMATIČKE FUNKCIJE: 
• drugi korijen 

=SQRT(A5)  � računa drugi korijen sadržaja ćelije A5 
• apsolutna vrijednost broja 

=ABS(B8)  � računa apsolutnu vrijednost broja u ćeliji B8 
• logaritam broja (po bazi 10) 

=LOG10(B8)  � računa vrijednost logaritma (po bazi 10) broja u ćeliji B8 
• logaritam broja (po bazi a) 

=LOG(D5;a) � računa logaritam broja u ćeliji D5 po bazi a  
• potenciranje 

=POWER(a;x)  � računa vrijednost xa , gdje brojevi a i x mogu biti i oznake ćelija 

VJEŽBA 1: Izradi sljedeću proračunsku tablicu koja će izračunavati: (izrađuje se samo računski dio 
dok se uređivanje tablice radi kasnije) 

1.) Ćelije C8:I8 sadrže prosječne dnevne izdatke po pojedinoj namirnici 
2.) Ćelije J3:J7 sadrže ukupne tjedne izdatke po namirnicama 
3.) Ćelije K3:K7 sadrže maksimalne tjedne izdatke za pojedinu namirnicu 
4.) Ćelije L3:L7 sadrže minimalne tjedne izdatke za pojedinu namirnicu 
5.) Sadržaj ostalih ćelija naveden je na slici. 
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VJEŽBA 2:  Kreiraj novu mapu pod imenom EXCEL1, unutar mape EXCEL1 stvori novu radnu 
knjigu (excel datoteku) pod imenom VJEZBA te u nju pohrani vježbu.  
Izradi sljedeću proračunsku tablicu koja prikazuje uspjeh učenika pri upisu na fakultet (računaju se startni bodovi 
iz škole, dodatni bodovi, te napisani test). (Upute o izradi su navedene ispod tablice) 
 

 

Upute za izradu formula: 
1.) U stupcu H (ćelije H3:H9) nalazi se broj bodova za pojedinog učenika osvojenih na testu (za svaki točno 

riješeni zadatak dobiva se 15 bodova, za svaki neriješeni zadatak 0 bodova, a za svaki netočno riješeni 
zadatak gubi se 4 boda).  

2.) U stupcu I (ćelije I3:I9) nalaze se ukupni bodovi za pojedinog učenika (ukupni broj bodova je zbroj startnih 
bodova, dodatnih bodova i test bodova (bodova osvojenih na testu), osim ako je učenik na testu točno riješio 
manje od 9 zadataka (tada je ukupni broj bodova jednak 0). 

3.) U ćelijama C11 i D11 nalaze se prosječni startni i prosječni dodatni bodovi prikazani na 1 decimalu. 
4.) U ćelijama E12, F12 i G12 nalazi se prosječni broj točnih, netočnih i neriješenih zadataka prikazanih na 3 

decimale) 
5.) U ćeliji E13 nalazi se najmanji broj točno riješenih zadataka. 
6.) U ćeliji F14 nalazi se najveći broj netočno riješenih zadataka. 
7.) U ćeliji C16 nalazi se broj učenika koji su stekli pravo upisa na fakultet (učenik je stekao pravo upisa na 

fakultet, ako mu je ukupni broj bodova ≥650. 
8.) U ćeliji C17 nalazi se ukupan broj učenika koji imaju dodatne bodove. 

Upute za uređivanje tablica: 
1.) Debljine svih rubnih linija određuju se prema slici. 
2.) Podaci u 2. redu (naslovni redak) poravnati su horizontalno u lijevo, a vertikalno dolje. 
3.) Svi brojevi u tablici poravnati su horizontalno i vertikalno u sredinu. 
4.) Sav tekst u tablici (osim u naslovnom redu) poravnat je horizontalno u lijevo, a vertikalno u sredinu. 

5.) Sav tekst unutar tablice pisan je fontom Times New Roman – 11 (osim teksta u naslovnom redu koji je pisan 
fontom Arial Narrow – 11), a svi brojevi fontom Garamond – 12 (podebljana i kosa slova podesi prema slici) 

6.) Imena učenika u ćelijama B3:B9 napisana su crvenim slovima 
7.) Boja pozadine ćelija u naslovnom retku je zelena, a u svim ostalim obojenim ćelijama na slici svjetlo plava. 
8.) Širina svih redaka iznosi 20, osim praznih redaka (1, 10, 15) koja iznosi 14. 
9.) Širina svih stupaca podešava se prema sadržaju ćelija, osim stupca A koja iznosi 3. 
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GRAFIKONI 

Grafikoni se koriste za grafički prikaz i usporedbu podataka obrađenih u proračunskim tablicama, kako 
bi oni bili uočljiviji ili razumljiviji. Pomoću njih se lakše uočavaju odnosi među podacima te ih je lakše 
usporediti. 
Da bismo izradili grafikon, najprije moramo označiti podatke koje želimo grafički prikazati, a zatim su 
nam na raspolaganju 3 mogućnosti: 

• odabrati Insert – Chart (ili alat  iz alatne trake) 
• korištenje alatne trake Chart (ako je uključena) 
• pomoću tipke F11 

Prvi navedeni način je osnovni (''školski'') 
način izrade grafikona. Odabirom Insert – 

Chart pokreće se ''Čarobnjak'' za grafikone 
(Chart Wizard) tj. postupak koji nas vodi 
kroz nekoliko koraka stvaranja grafikona. 
Postupak ćemo opisati na primjeru tablice sa 
slike (desno). 

1. korak:  Odabir vrste grafikona 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dijaloški prozor za odabir vrste grafikona 

Nakon označavanja podataka koje želimo grafički prikazati otvara se dijaloški prozor u kojem su 
prikazani grafikoni poredani po vrstama (Chart type), a svaka vrsta sadrži podvrste s nekoliko varijacija 
(Chart sub-type). Izbor grafikona ovisi o podacima koji će se njime prikazati. Kada označimo vrstu 
grafikona, pojaviti će se njen opis i namjena, tj. za kakav se prikaz podataka koristi, što nam olakšava 
izbor grafikona (nisu sve vrste grafikona primjerene za sve vrste podataka). Klikom na gumb za pregled 
grafikona (''Press and Hold to View Sample'') možemo vidjeti izgled izabranog grafikona kada se 
primjeni na označenim podacima. Nakon odabira vrste grafikona kliknemo na gumb Next i prelazimo 
na sljedeći korak. 
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2. korak:  Određivanje raspona i prikaza podataka u grafikonu 

Dijaloški prozor za odabir raspona i prikaza podataka 

Ako smo prije pokretanja čarobnjaka označili podatke za prikaz (odredili raspon podataka, a u našem 
primjeru smo to učinili) onda polje Data range ne moramo mijenjati (ono sadrži adrese označenih 
podataka). Zatim pod Series in odredimo način prikaza podataka (Rows – prikaz po retcima, Column – 
prikaz po stupcima). Unutar kartice Series možemo upisati imena za sve dijelove (trake). Klikom na 
gumb Next prelazimo na sljedeći korak. 

3. korak:  Određivanje elemenata grafikona (naslov, osi, legenda, oznake itd.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dijaloški prozor za određivanje elemenata grafikona 

Elementi grafikona određuju se unutar pojedinih kartica. Npr. 



Proračunske tablice (Microsoft Excel)  19 

Titles - za određivanje naslova grafikona, a ovisno o vrsti grafikona za određivanje naslova na X i Y osi 
(naslovi se upisuju u odgovarajuća polja). 
Axes - za uključivanje (isključivanje) natpisa (skale) na osima 
Gridlines - za uključivanje (isključivanje) mreže unutar grafikona  
Legend - za uključivanje (isključivanje) i pozicioniranje legende 
Data Labels - za uključivanje (isključivanje) oznaka (natpisa) iznad stupaca grafikona 
Data Table - za uključivanje (isključivanje) tablice s podacima ispod grafikona 

Unutar svake pojedine kartice odredimo pojedine elemente, nakon završetka kliknemo na gumb Next za 
sljedeći korak 

4. korak:  Pozicioniranje grafikona 

 
 
 
 
 
 
 
 
 
 
 

Dijaloški prozor za pozicioniranje grafikona 

 
U ovom (posljednjem) koraku određujemo da li želimo da se grafikon prikaže na posebnom radnom 
listu (označimo opciju As new sheet) ili kao objekt na nekom od postojećih radnih listova (označimo 
opciju As object in), a zatim unutar polja odaberemo željeni radni list. Na kraju kliknemo na gumb 
Finish nakon čega se pojavi grafikon.  

Napomena: ako na kraju 3. koraka kliknemo na gumb Finish (umjesto Next) grafikon će se pojaviti kao 
objekt u aktivnom radnom listu 
Napravljeni grafikon možemo naknadno mijenjati i podešavati na sljedeće načine:  

1.) učinimo desni klik na dio grafikona kojeg želimo mijenjati, a zatim iz brzog izbornika izaberemo 
opciju koju želimo podesiti 

2.) dvoklikom na objekt koji želimo urediti (time se otvara dijaloški prozor za podešavanje) 

3.) označimo objekt grafikona koji želimo oblikovati te iz izbornika Format biramo ponuđene opcije za 
uređivanje nakon čega se otvara određeni dijaloški prozor za uređivanje. 

4.) označimo objekt grafikona i odaberemo alat za uređivanje sa alatne trake Chart (opisano u 
nastavku) 

 
Izrada grafikona pomoću alatne trake Chart 

Ukoliko alatna traka Chart nije uključena, uključimo je tako da odaberemo View – Toolbars – Chart.  
 

 

 

 
 Traka Chart za izradu grafikona 
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Označimo najprije podatke na temelju kojih želimo napraviti grafikon, a zatim klikom na ikonu Chart 

type unutar padajućeg izbornika izaberemo vrstu grafikona nakon čega Excel napravi osnovni oblik 
grafikona kojeg je dalje potrebno urediti koristeći ikone alatne trake Chart. 
 
Naredbe (ikone) alatne trake Chart: 

 

Ikona Naziv Namjena 

 

Chart objects odabir područja grafikona koje želimo uređivati 

 
Chart type odabir vrste grafikona 

 
Format plot area oblikovanje označenog područja grafikona 

 Legend uključivanje (isključivanje) legende 

 
Data table uključivanje (isključivanje) tablice s podacima 

 
By row prikaz podataka po retcima 

 
By column prikaz podataka po stupcima 

 
Angle Text Downward

ispis teksta unutar grafikona pod kutem 
(u smjeru kazaljke na satu)   

 
Angle Text Upward

ispis teksta unutar grafikona pod kutem 
(suprotno od kazaljke na satu)   

 

Rad s grafikonom 

Postojeći grafikon možemo po potrebi mijenjati (uređivati) tako da svaki objekt grafikona uređujemo 
posebno. Pojedini objekt (naslov, legenda, os i sl.) označimo tako da kliknemo na njega, a zatim na 
alatnoj traci izaberemo potrebni alat za uređivanje. Nakon što je objekt označen možemo ga po potrebi i 
premještati, mijenjati mu veličinu, obrisati ili uređivati po želji. 
Grafikon premještamo tako da ga pomoću lijeve tipke miša uhvatimo i odvučemo na željeno mjesto, a 
veličinu mu mijenjamo tako da uhvatimo jedan kut područja grafikona te ga vučemo prema van da 
bismo ga povečali ili prema unutra da bismo ga smanjili (time se proporcionalno povećaju ili smanje svi 
objekti grafikona kao npr. naslov, legenda itd.) 
 
Pregled ispisa  

Pregled ispisa koristimo da bismo provjerili izgled tablice prije ispisa i učiniti eventualne korekcije. 

Pozivamo ga naredbom File – Print Preview ili klikom na alat  sa alatne trake. U pregledu ispisa 
tablica izgleda onako kako će se ispisati na papiru, a za vršenje podešavanja koristimo gumbe Next i 
Previous za sljedeću i prethodnu stranicu radnog lista. Pomoću gumba Zoom možemo povećati prikaz 
stranice na zaslonu, a drugim klikom na isti gumb vraćamo prikaz stranice na prethodnu veličinu. 
Gumbom Margins možemo uključiti (isključiti) oznake margina stranice, a dok su oznake uključene 
možemo mijenjati veličine margina te zaglavlja i podnožja stranice tako da povučemo oznaku (crtu) u 
željenom smjeru. Pregled ispisa zatvaramo gumbom Close. 
 


